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Welcome to MTE 
Meridian Terminal Emulator (MTE) allows you to use your personal computer 
(PC) to access the supervisor displays in the Meridian MAX, Customer 
Controlled Routing (CCR), and Network Administration Center (NAC) 
applications. 

Two major new features have been added in MTE 9. These features allow you to 
do the following:

• Use a graphical user interface while working with the agent status displays. 
Note: This feature is available only in MTE 9 running with Meridian MAX 
9. If you are using MTE 9 with Meridian MAX 8 or lower, the displays are 
shown as a VT220 terminal emulation. 

• Use MTE to access NAC. NAC allows you to monitor multiple Meridian 
MAX sites from one central location. 

The features offered in previous versions of MTE are continued in MTE 9. These 
features allow you to do the following:

• Send Meridian MAX reports to any printer supported by your PC. The 
printer can be directly connected to the PC or accessible through a Local 
Area Network (LAN). If you connect to NAC, you can also print NAC 
reports to your printer.

• Use context-sensitive programmable buttons to automate your navigation to 
specific screens. In Meridian MAX, separate buttons can be programmed for 
each screen. In CCR, a set of buttons can be programmed for use exclusively 
by all the CCR screens.

• Use address book entries to save different connection settings that 
supervisors frequently use to connect to the Meridian MAX, CCR, or NAC. 

• Import or export the address books and programmable buttons.
• Save data to a file for use by third-party applications.
• Use a LAN, a modem, or a serial (RS-232) port to connect to Meridian 

MAX, CCR, or NAC.
• Open more than one MTE session on a PC running Windows 95 or 

Windows NT.
• Customize the color of elements on your Meridian MAX supervisor screen.

New in MTE 9

Ongoing and enhanced MTE features
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• Provide the equivalent of running CCR or NAC on a VT220 workstation.
• Run your supervisor sessions on the same PC as the MAXcaster forecasting 

tool, and send your Meridian MAX report data to a file created for 
MAXcaster.

For more information

For more information, see the following:

• For Meridian MAX features, refer to the Meridian MAX 9 Supervisor’s  
User Guide (P0881392).

• For Microsoft Windows functions, refer to the Microsoft Windows 
documentation.

• For CCR features, refer to the Customer Controlled Routing User Guide 
(P0729367).

• For NAC features, refer to the Network Administration Center (NAC) 2 
Supervisor’s User Guide (P0724352).

For more information
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Preparing the Meridian MAX or NAC
This section describes the settings that must be adjusted on the Meridian MAX or 
NAC before the MTE can be used properly. 

To prepare Meridian MAX to run MTE 9, your system administrator or 
maintenance technician must do the following.

1. Set the terminal type in the Meridian MAX Communication Port 
Assignment display to “MTE 9 or above.” For more information, refer to the 
Meridian MAX 9 Maintenance and Diagnostics Guide (NTP 553-4001-811), 
“Configuring the Meridian MAX” chapter, “Meridian MAX Hardware 
Configuration” section.

2. Set the Agent Status Timer field on the Miscellaneous Options display to 
“On MTE 9 or higher only.” This is required only if you want to use this 
feature in MTE 9 or higher. For more information, refer to the Meridian 
MAX 9 Supervisor’s User Guide (P0881392), “Parameter Administration” 
chapter, “Miscellaneous Options” section.

 

To prepare NAC to run MTE 9, your system administrator or maintenance 
technician must do the following.

1. Set the terminal type in the NAC Communication Port Assignment display 
to “MTE 9 or above.” 

Confirming the Meridian MAX settings

Confirming the NAC settings
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Installing MTE 9
This section describes how to install MTE on your PC.

The following minimum requirements must be met to run MTE 9 on your PC:

MTE minimum requirements

Software/hardware Minimum requirement

Meridian MAX Release 5.27 (or higher)
Note: Full functionality requires 
Meridian MAX 9.x or higher.

CCR • Release 3.5x (with a LAN)
• none (with a modem or serial 

port)

NAC • Release 2.5

Microsoft Windows • Windows Release 3.1
• Windows NT Release 3.51 or 4.0
• Windows 95

Personal computer • Windows 3.1 (386 DX 20 MHz 
IBM compatible)

• Windows NT (486 DX 33 MHz 
IBM compatible)

• Windows 95 (486 DX 33 MHz 
IBM compatible)

Monitor Color VGA

Free RAM 4 Mbytes for Windows 3.1
16 Mbytes for all other platforms 
(Windows 95, Windows NT 3.51, and 
Windows NT 4.0)

Free hard disk 2 Mbytes

Connection type • modem or serial (RS-232) port
• LAN with WinSock 1.1 compliant 

network operating software
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To upgrade to MTE 9, follow the “To install MTE 9” procedure. 

To do an upgrade, you must also have a previous version of MTE on your PC. If 
a previous version is not detected, the upgrade procedure will not be completed.

You must follow this procedure to install or upgrade to MTE 9 on your PC. 
Before you begin, ensure that all of the minimum requirements for MTE 9 are 
met.

Note: If you are using a Windows NT system, do not log in as a guest. This 
may cause problems with MTE’s installation.

1. Insert the MTE 9 disk labeled Disk 1 into your floppy disk drive. 

2. Select Run from the File menu in Program Manager or from the Start menu.

The Run dialog box appears.

3. Type the location of your setup file.

• If the MTE 9 disk is in your A floppy drive, type a:\setup.
• If the MTE 9 disk is in your B floppy drive, type b:\setup.

4. Click OK.

If you are installing a multilingual version of MTE, a screen appears asking 
you to select a language. Ensure that the language is compatible with both 
the language selected on your PC operating system and your application 
(Meridian MAX, CCR, or NAC). For example, a German supervisor will use 
German MTE on a German operating system.

To upgrade to MTE 9

To install MTE 9
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5. Click the language in which you want MTE to run, and then click Continue.

The next setup screen appears. 

6. Click Continue.

Note: If you are upgrading from an earlier version, the setup program looks 
for the older MTE release on your PC. If it is not found, the program stops 
the upgrade procedure and displays an information dialog box asking you to 
restart. Before restarting the installation, reinstall the older version of MTE.
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The next setup screen appears.

7. Enter the path and directory.

• If you want to accept the given default path and directory name, click 
Continue.

• If you want to specify a path and directory name that are different from 
the default, enter them in the data entry field and click Continue. An 
example of a valid entry for the path and directory name is D:\MTE8.

A pop-up window appears showing the progress of the installation. 

8. When prompted, insert the MTE disk requested by the setup program.

Note: The setup program prompts you to insert Disk 2 or Disk 3.

The installation continues. When the installation is finished, the last setup 
screen appears.

9. Click OK.

The window closes.
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10. Remove the MTE disk from your floppy disk drive.

11. If you are running under Windows NT, open the Property dialog box for the 
MTE icon, and select Run in Separate Memory.
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Connecting to an application
This section describes how to use a serial port, LAN, or modem to connect to 
your Meridian MAX, CCR, or NAC applications. To connect to your application, 
MTE automatically uses the connection settings defined in one of the following:

• an address book entry defined as the system default
For more information on address books, see page 1-17.

• the factory default settings predefined in MTE
If a system default is not specified, MTE uses the factory default settings to 
connect to your application. For more information on the factory default 
settings, see page 1-13.

1. Double-click the MTE icon.

The MTE window appears, displaying the Nortel logo and copyright 
information. The logo and copyright disappear after a few seconds. The 
word “Connected” also appears in the status bar at the bottom of the MTE 
window.

To connect using a LAN
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2. In the Settings menu, click Edit Options.

The Options dialog box appears.

3. In the Connection Type area, click LAN.

4. In the IP Address field, enter the IP address.

5. In the Emulation Type field, click MAX, CCR, or NAC.

6. Click OK to return to the MTE window.

7. Wait for your PC to connect to the Meridian MAX, CCR, or NAC.

If the connection is successful, the Meridian MAX, CCR, or NAC login 
screen appears. 

8. Log in to your application, entering your ID and password as prompted.

Your Meridian MAX, CCR, or NAC main menu appears.
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1. Double-click the MTE icon.

The MTE window appears, displaying the Nortel logo and copyright 
information. The logo and copyright disappear after a few seconds. The 
word “Connected” also appears in the status bar at the bottom of the MTE 
window.

2. In the Settings menu, click Edit Options.

The Options dialog box appears.

3. In the Connection Type area, click COM 1 or COM 2.

Note: Do not assign MTE to the same port used by the printer or other 
devices.

4. In the Connection Speed area, click 9600 Baud.

5. In the Emulation Type field, click MAX, CCR, or NAC.

6. Click OK to return to the MTE window.

7. Wait for your PC to connect to the Meridian MAX, CCR, or NAC.

If the connection is successful, the Meridian MAX, CCR, or NAC login 
screen appears. 

8. Log in to your application, entering your ID and password as prompted.

Your Meridian MAX, CCR, or NAC supervisor main menu appears.

To connect using a serial port

MTE9UserBook : e4b_con  Page 11  Friday, October 2, 1998  2:10 PM



Connecting to an application

Standard 1.0 1-12 August 1998

1. Double-click the MTE icon.

The MTE window appears, displaying the Nortel logo and copyright 
information. The logo and copyright disappear after a few seconds. The 
word “Connected” also appears in the status bar at the bottom of the MTE 
window.

2. In the Settings menu, click Edit Options.

The Options dialog box appears.

3. In the Connection Type area, click COM 1 or COM 2.

4. In the Emulation Type field, click MAX, CCR, or NAC.

5. Click OK to return to the MTE window.

6. Type at&f  followed by Return at the modem prompt on your screen.

The modem responds with OK.

7. Type atdt and the phone number followed by Return. 

Use commas where you want the modem to pause for two seconds during 
dial-up. For example, to dial 9-555-1212 where a 9 is dialed to obtain an 
outside line, type atdt 9,5551212

Refer to your modem documentation for more information on dialing in to a 
remote site.

The system dials the number you have entered.

8. Wait for the modem to indicate that you are connected.

Once you are connected, you may be asked to specify the display type that 
you are using.

9. Specify the display type that you are using.

• If you are connecting to Meridian MAX 9 (or higher) or NAC 2.5, select 
MTE 9 or above. 

• If you are connecting to Meridian MAX 8 or higher, select MTE 8. 
• If you are connecting to Meridian MAX 7 or lower, select MTE 7 or  

lower.
• If you are connecting to CCR and you are prompted for a display type, 

select VT220.

10. Log in to your application, entering your ID and password as prompted.

Your Meridian MAX, CCR, or NAC main menu appears.

To connect using a modem
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MTE uses the factory default settings to connect to the Meridian MAX in the 
following situations:

• You are installing MTE for the first time.
• The system default has been deleted. MTE uses the original factory default 

settings to connect to the Meridian MAX when the system default is deleted. 

The factory default settings are as follows:

• Alias Name (Unknown Host)
• Communication Type (COM 1)
• Connection Speed (9600 baud)
• Emulation Type (Meridian MAX)
• Printer Port (Windows default printer)

If you are upgrading from MTE 5 or installing MTE 9 for the first time, MTE  
automatically creates the “Unknown Host” entry in the address book. This entry 
contains all of these factory default settings.

If you are upgrading from MTE 6 or MTE 7, MTE still creates the  “Unknown 
Host” entry in the address book. However, the other values for this entry are 
inherited from the system default settings created in the previous version of 
MTE. 

If you are upgrading from MTE 8, the address book remains unchanged.

Note: It is recommended that you do not modify the factory default settings.

1. Double-click the MTE icon.

If an address book entry has not been defined as the system default, MTE 
uses the factory default settings. The MTE window appears, displaying the 
Nortel logo and copyright information. The logo and copyright disappear 
after a few seconds. The word “Connected” also appears in the status bar at 
the bottom of the MTE window.

2. Wait for your PC to connect to the Meridian MAX, CCR, or NAC.

If the connection is successful, the Meridian MAX, CCR, or NAC login 
screen appears. 

3. Log in to your application, entering your ID and password as prompted.

Your Meridian MAX, CCR, or NAC main menu appears.

To connect using the factory default settings
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If you experience problems connecting to your Meridian MAX, CCR, or NAC, 
try the following:

• Ask your system administrator to check that the Meridian MAX, CCR, or 
NAC is running.

• Ask your network administrator to check that the network software is 
configured correctly. 

• Make certain that the port used by MTE is not used by the printer or other 
devices.

To fix a connection problem
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Using the MTE toolbar
MTE allows you to carry out various procedures by clicking buttons on the 
toolbar. Each button represents one of the MTE menu commands. This table 
describes the functions of each of the toolbar buttons.

Button Name Function

Restart Session Restarts the supervisor session.

Address Book Opens the Address Book dialog box.

Exit Exits MTE.

Copy Copies the highlighted text to your 
clipboard.

Options Opens the Options dialog box.

Font Opens the Font dialog box.

Customize 
Buttons

Opens the Customize Buttons dialog box. 
This button is available only when the 
programmable buttons are enabled.

Enable Buttons Enables the programmable buttons. This 
button is available only when the 
programmable buttons are disabled.

Disable Buttons Disables the programmable buttons. This 
button is available only when the 
programmable buttons are enabled.

Print Setup Opens the Print Setup dialog box. This 
button is available only when the MTE is 
connected to the Meridian MAX.
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Button Name Function

Print Preview Opens the Print Preview dialog box. This 
button is available only if you are 
connected to Meridian MAX 8.6x or 
higher, and a report is ready to be 
previewed.

About Displays version and copyright 
information.

Help Displays the MTE online help. 
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Using address books
This section describes how to use entries in the address book.  

Address book entries contain settings to link your PC to different supervisor 
sessions in the Meridian MAX, CCR, or NAC. These settings can be saved and 
reused. A maximum of 30 entries can be created in an address book.

Only one address book can be active on your PC at one time. If you have more 
than one MTE session running on your PC, any changes made to the address 
book in one session are applied to all the other active MTE sessions.

The Address Book dialog box must be displayed to create or access an address 
book entry. The dialog box lists all of the entries in an address book.

1. From the Session menu, select Address Book or click the Address Book 
button on the toolbar.

The Address Book dialog box appears. If an address book entry has been 
defined as the system default, it is identified by a check mark.

To display the Address Book dialog box
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1. From the Session menu, select Address Book or click the Address Book 
button on the toolbar.

The Address Book dialog box appears. 

2. Click New.

The New Address dialog box appears.

3. In the Alias Name field, type a unique name to identify the address book 
entry. 

The name is case-sensitive and can be up to 30 characters in length. 

To create an address book entry
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4. Select a connection type.

• If you want to connect to the Meridian MAX, CCR, or NAC through a 
serial port or modem, click COM 1 or COM 2.

• If you want to connect through a LAN, click LAN and enter the IP 
address or host name of the Meridian MAX, CCR, or NAC. The LAN 
button is disabled if WinSock 1.1 compliant network operating software 
is not installed on the PC. 

5. Select a connection speed.

• If you are using a serial port or a modem, click 9600 baud.
• If you are using a LAN, you cannot select a connection speed.

Note:  If you are connected through a serial port, the baud rate should not be 
changed from the default setting of 9600 baud. This parameter is used by 
your application to communicate with the supervisor displays. 

6. Select an emulation type.

• If you want to connect to a Meridian MAX, click MAX.
• If you want to connect to a CCR, click CCR.
• If you want to connect to a NAC, click NAC.

7. Select a printer port.

• If you want to print your Meridian MAX reports, click Printer.

For more information on printing reports, see page 1-55.

• If you want to send your Meridian MAX or NAC reports to a file, click 
File and enter the path and file name that you want to use.

For example, type C:\MTE\NEWFILE . For more information on 
saving reports to a file, see page 1-49.

• If you want to use your Meridian MAX report data in the MAXcaster 
forecasting tool, click MAXcaster. 

For more information on saving data for MAXcaster, see page 1-51.
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8. Save your record.

• If this entry is to be saved but not used as the system default, click OK.

The New Address dialog box closes. The name of your new address 
book entry appears in the Address Book dialog box. 

• If this entry is to be saved as the system default, click Make Default 
followed by Yes.

The New Address dialog box closes. A check mark appears beside the 
name of your new address book entry in the Address Book dialog box. 
This indicates that this is the system default. 

Note:  When MTE is started, it automatically uses the system default to 
connect to the Meridian MAX, CCR, or NAC. This address book entry 
remains the system default until you select a new one. If a system default is 
not assigned, MTE uses the factory defaults. For more information on the 
factory default settings, see page 1-13.

9. Click Close to return to the MTE window.

10. To activate the new address book entry, follow the procedure described in 
the “To connect to an address book entry” section below.

MTE must be told which address book entry to use to create a link to the 
Meridian MAX, CCR, or NAC.

1. From the Session menu, select Address Book, or click the Address Book 
button on the toolbar.

The Address Book dialog box appears with a list of existing address book 
entries.

2. With the alias name of the address book entry highlighted, click Connect, or 
double-click the name of the entry.

The Address Book dialog box is closed. When the connection is made, the 
Meridian MAX, CCR, or NAC screen appears. The name of the selected 
address book entry also appears in the title of the MTE window. 

To connect to an address book entry
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1. From the Session menu, select Address Book, or click the Address Book 
button on the toolbar.

The Address Book dialog box appears with a list of the address book entries.

2. With the alias name of the address book entry highlighted, click Modify.

The Modify Address dialog box appears. 

3. Make your changes to the address book entry.

4. Save your modifications.

• If this entry is to be saved but not used as the system default, click OK.

The options are saved and the Modify Address box closes. 

• If this entry is to be saved as the system default, click Make Default 
followed by Yes.

The changes are saved. In the Address Book dialog box, a check mark 
appears beside your address book entry to indicate that it is the system 
default.

To modify an address book entry
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If an address book entry is renamed while it is in use, the new name is displayed 
in the MTE window. If you are running other MTE sessions at the same time, the 
new name does not appear until each session is terminated and restarted. If the 
address book entry was the system default, it remains the system default after it is 
renamed.

1. From the Session menu, select Address Book, or click the Address Book 
button on the toolbar.

The Address Book dialog box appears with a list of existing address book 
entries.

2. With the alias name of the address book entry highlighted, click Rename.

The Rename Alias dialog box appears.

3. In the New Alias Name field, type the new name of the address book entry.

4. Click OK to return to the Address Book dialog box.

5. Click Close to return to the MTE window.

To rename an address book entry
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An address book entry cannot be deleted while it is in use by MTE. If you delete 
an entry that is being used as the system default, a dialog box appears asking you 
to confirm the deletion. Once you delete the system default, the factory default 
settings are used until another address book entry is selected as the system 
default.

1. From the Session menu, select Address Book, or click the Address Book 
button on the toolbar.

The Address Book dialog box appears with a list of existing address book 
entries.

2. With the alias name of the address book entry highlighted, click Delete.

3. In the confirm dialog box, click Yes.

The entry is deleted from the Address Book dialog box.

4. Click Close to return to the MTE window.

An address book can be exported from your MTE and saved into a file. This file 
can then be imported by other PCs running MTE. You should not use other 
applications to alter the contents of an address book file.

1. From the Session menu, select Export File.

2. From the Export File submenu, select Address Book.

The Save As dialog box appears.

3. Assign the directory and file name to be used to save the address book. 

4. Click Save.

The selected address book is saved to the assigned directory. The system 
automatically formats the address book file for use exclusively by MTE.

To delete an address book entry

To export an address book
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An address book can be imported and shared by other PC users running 
Microsoft Windows. Do not use other applications to alter the contents of an 
imported address book file.  

Only an address book file which has been exported from MTE on a PC can be 
imported.

1. Copy the exported address book file to your PC.

2. From the Session menu, select Import File.

3. From the Import File submenu, select Address Book.

The Open dialog box appears.

4. Locate the directory and folder containing the address book file.

5. Double-click the address book file to be imported.

The selected address book is copied to MTE. If an address book is already in 
use, a dialog box appears asking if you want to overwrite it.

6. Click Yes to confirm the import.

7. Click Close to return to the MTE window.

To import an address book
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Monitoring agents
The Agent Status Display feature allows you to monitor the status of the agents 
and the queues they are servicing. You can also use this feature to reassign 
agents, queues, priorities, and supervisors. With MTE 9, the agent status displays 
are presented with a GUI interface. This interface provides pull-down menus to 
replace the softkey functions used in MTE 8 or lower. This feature is available 
only if the MTE 9 is connected to Meridian MAX 9. 

This section describes only how to navigate through the three agent status 
displays using MTE 9. For detailed descriptions on the displays and fields, please 
refer to the Meridian MAX 9 Supervisor’s User Guide (P0881392), “Agent Status 
Display” chapter.

In MTE 9, programmable buttons are not available on the agent status displays.

Note: If you are not running MTE 9, the agent status displays are shown 
using the VT220 terminal emulation. All the other Meridian MAX displays 
are presented with the VT220 terminal emulation, even if MTE 9 is used.

To access the agent status displays, follow these steps.

1. Display the Meridian MAX main menu.

 

To use agent status displays
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2. From the Meridian MAX main menu, select Agent Status Display.

One of three agent status displays appears. In this example, the Agent Status 
Timer Display is shown. 

3. To access the options to navigate around the three agent status displays, 
select Real-time from the MTE menu. 

The Real-time pull-down menu appears.
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The agent status displays can be shown in a supervisor or global view.

The supervisor view shows the status of all agents assigned to a specific 
supervisor. The name or ID of the supervisor appears in the title status bar at the 
top of the screen. The supervisor view option is not available if the agent 
information is already in supervisor mode on the display.

To use the supervisor view, the Meridian 1 Position ID must be defined in the 
supervisor’s profile. This also allows the supervisor to toggle between the 
supervisor view and the global view. For more information, refer to the Meridian 
MAX 9 Supervisor’s User Guide (P0881392), “Parameter Administration” 
chapter, “Supervisor Definition” section.

To view the displays in supervisor view, follow these steps.

1. From the Real-time menu, select View.

The View submenu appears.

2. From the View submenu, select Supervisor View. 

The data for the agents assigned to the supervisor appear in the display. The 
words “Supervisor View” in the title bar at the top of the display indicate 
that you are in Supervisor View.

To monitor agents by supervisor view
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The global view displays the status of all the agents in the system.

To use the Global View option, the Global Statistics field must be enabled in 
your supervisor profile. It is also not available if the agent information is already 
shown in global mode on the display. For more information on the supervisor 
profile, refer to the Meridian MAX 9 Supervisor’s User Guide (P0881392), 
“Parameter Administration” chapter, “Supervisor Definition” section.

To view the displays in global view, follow these steps.

1. From the Real-time menu, select View.

The View submenu appears.

2. From the View submenu, select Global View.

The data for all the agents appears on the display. The words “Global 
View” in the title bar at the top of the display indicate that you are in Global 
View.

The Agent Status by ACD-DN Display allows you to view the agent data sorted 
by queue.

For more information on this display, refer to the Meridian MAX 9 Supervisor’s 
User Guide (P0881392), “Agent Status Display” chapter, “Agent Status by 
ACD-DN Display” section.

To monitor the agents by ACD-DN, follow these steps.

1. From the Real-time menu, select Format.

The Format submenu appears.

To monitor agents by global view

To monitor agents by ACD-DNs
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2. From the Format submenu, select “by ACD-DN.”

The Agent Status by ACD-DN Display appears.
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The Agent Status by Position Display allows you to view the agent data sorted by 
position ID.

For more information on this display, refer to the Meridian MAX 9 Supervisor’s 
User Guide (P0881392), “Agent Status Display” chapter, “Agent Status by 
Position Display” section.

To monitor the agents by positions, follow these steps.

1. From the Real-time menu, select Format.

The Format submenu appears.

2. From the Format submenu, select “by Position.”

The Agent Status by Position Display appears.

To monitor agents by positions
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The Agent Status Timer Display allows you to view the agent data using the 
position ID and timer. The timer indicates the amount of time an agent has been 
doing certain types of activities.

For more information on this display, refer to the Meridian MAX 9 Supervisor’s 
User Guide (P0881392), “Agent Status Display” chapter, “Agent Status by 
Timer Display” section.

To monitor the agents by position ID and timer, follow these steps.

1. From the Real-time menu, select Format.

The Format submenu appears.

2. From the Format submenu, select Agent Status Timer With Positions. 

The Agent Status Timer Display appears with its Timer field. The agents are 
identified by position ID.

To monitor agents using the position and timer
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The Agent Status Timer Display allows you to view the agent data using the 
agent name and timer. The timer indicates the amount of time an agent has been 
doing certain types of activities.

For more information on this display, refer to the Meridian MAX 9 Supervisor’s 
User Guide (P0881392), “Agent Status Display” chapter, “Agent Status by 
Timer Display” section.

To monitor the agents by agent name and timer, follow these steps.

1. From the Real-time menu, select Format.

The Format submenu appears.

2. From the Format submenu, select Agent Status Timer with Agent Name.

The Agent Status Timer Display appears with the Timer field. The agents are 
identified by agent name. 

To monitor agents using the agent name and timer
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From the Real-time menu, you can access the Configuration Control feature in 
Meridian MAX. This feature allows you to adjust various options on the 
Meridian 1. The Configuration Control pop-up window appears at the bottom of 
the agent status display using the VT220 terminal emulation.

While the Configuration Control window is being viewed, MTE 9 continues to 
update the agent status displays. Since the Configuration Control feature uses 
VT220 terminal emulation, the programmable buttons are not available with the 
display. 

Note: The Configuration Control feature is not available from the Agent 
Status Timer with Agent Name display.

For more information on the Configuration Control feature, refer to the Meridian 
MAX Supervisor’s User Guide (P0881392), “Configuration Control” chapter.

To access the Configuration Control feature, follow this step.

1. From the Real-time menu, select Configuration Control.

The Configuration Control pop-up window appears at the bottom of the 
agent status display. 

To access the Configuration Control feature
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From the Real-time menu, you can print a snapshot of the information on the 
agent status display that you are viewing. The information is printed to the 
default printer specified in the Print Setup option (located through the Session 
menu).

To print the agent status information, follow this step.

1.  From the Real-time menu, select Print Snap Shot.

The snapshot of the display is captured and printed.

From the Real-time menu, you can switch from any of the agent status displays to 
a queue statistics display. This allows you to monitor the performance of the 
queues.

When the queue statistics display is being viewed, the agent status display and 
Configuration Control window (if opened) are closed. The queue display is 
shown using the VT220 terminal emulation.

For more information on the Queue Statistics Display feature, refer to the 
Meridian MAX Supervisor’s User Guide (P0881392), “Queue Statistics Display” 
chapter.

To access a queue statistics display, follow these steps.

1.  From the Real-time pull-down menu, select Queue Display.

A queue statistics display appears.

To print the agent status information

To monitor queues
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2. To return to the agent status display, press the [Agent Display] function key.

The agent status display appears.
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In the agent status displays, you can search for an agent based on the agent ID, 
position ID, or agent name.

The system can respond to the search in a variety of ways:

• If the search is successful and the agent is only servicing one queue, the 
matching entry appears at the top of the display.

• If you are searching for an agent on the Agent Status by ACD-DN Display 
and the agent is servicing multiple queues, a pop-up window appears. The 
pop-up window displays a list of the ACD-DNs being serviced by the agent 
in the order the agent used to log in to them. Select the ACD-DN that you 
want from the list, and it appears at the top of the display.

• If you are searching for an agent on the Agent Status by Position Display and 
the agent is servicing multiple queues, the first matching entry appears at the 
top of the display.

• If the search is unsuccessful, an error message appears.

Search by Agent ID

To search by agent ID, follow these steps.

1. From the Real-time menu, select Locate Agent.

The Locate Agent submenu appears.

To locate an agent
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2. From the Locate Agent submenu, select “by Agent ID.”

The Locate Agent By Agent ID window appears.

3. In the Agent ID field, enter the identification number of the agent. 

4. Press OK.

MTE9UserBook : e6e_mon  Page 37  Friday, October 2, 1998  2:10 PM



Monitoring agents

Standard 1.0 1-38 August 1998

Search by Agent Name

To search by agent name, follow these steps.

1. From the Real-time menu, select Locate Agent.

The Locate Agent submenu appears.

2. From the Locate Agent submenu, select “by Agent Name.”

The Locate Agent By Agent Name window appears.

3. In the Agent Name field, enter the agent’s name.

It is possible for different agents to have the same name. If this occurs, a 
secondary menu of the matching agent IDs is presented. 
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4. Select the agent ID from the list.

5. Press OK.

Search by Position

To search by position ID, follow these steps.

1. From the Real-time menu, select Locate Agent.

The Locate Agent submenu appears.

2. From the Locate Agent submenu, select “by Position.”

The Locate Agent By Position ID window appears.
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3. In the Position ID field, enter the identification number of the position.

When MQA is enabled, it is possible to have an agent assigned to different 
ACD-DNs. If this occurs, a secondary menu of the matching ACD-DNs is 
presented. 

4. Select the ACD-DN from the list.

5. Press OK.
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From the Real-time menu, you can show all the spare positions on the agent 
status displays. These are positions that do not have agents logged in. 

To display the spare agent positions, follow these steps.

1.  From the Real-time menu, select Spare Positions.

The Spare Positions submenu appears. 

2. From the Spare Positions submenu, select Show.

All of the spare positions appear. The Show option is not available if the 
spare positions are already shown on the display. 

To show spare agent positions
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From the Real-time menu, you can hide all the spare positions on the agent status 
displays. These are positions that do not have agents logged in. 

To hide the spare agent positions, follow these steps.

1. From the Real-time menu, select Spare Positions.

The Spare Positions submenu appears. 

2. From the Spare Positions submenu, select Hide.

The spare agent positions are hidden on the display. The Hide option is not 
available if the spare positions are already hidden.

The Next Supervisor option allows you to monitor the queues and agents of other 
supervisors assigned to your supervisory group in your profile. This option can 
only be used if the Group Member Definition field is enabled in your profile and 
at least two supervisors are assigned to your supervisory group. The agent status 
display being viewed must also be in Supervisor View.

For more information on the Group Member Definition, refer to the Meridian 
MAX Supervisor’s User Guide (P0881392), “Parameter Administration” chapter, 
“Supervisor Definition” section.

To use the Next Supervisor option, follow these steps.

1.  Check that the agent status display is in Supervisor View.

The words “Supervisor View” appear in the title bar at the top of the display 
if you are in Supervisor View. If you are not in Supervisor View, follow the 
steps described in “To monitor agents by supervisor view” on page 1-27.

2. From the Real-time menu, select Next Supervisor.

The agent data for the next supervisor in your group appears on the display.

To hide spare agent positions

To view agents and queues for other supervisors
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To exit the agent status display feature in MTE, follow this step.

1. From the Real-time menu, select Exit Real-time Agent Display.

The Meridian MAX main menu appears.

To exit agent status displays
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Changing the connection settings
This section describes how to change the settings used to connect to the Meridian 
MAX, CCR, or NAC.

MTE allows you to make ad hoc changes to the address book entry currently in 
use. The changes are effective immediately. They remain effective, however, 
only for the current session. The changes are lost after you select another address 
book entry or terminate MTE. 

1. From the Settings menu, select Edit Options.

The Options dialog box appears to display the connection settings for the 
address book entry currently in use.

2. If you want to use another address book entry, select it from the Alias Name 
pull-down list.

3. Change the options.

A description of the fields is embedded in the procedure on page 1-18.

The alias name of the address book entry cannot be changed from this 
screen. It can be changed only by following the renaming procedure on 
page 1-22. 

4. Click OK.

A pop-up dialog box appears asking if you want to update the address book.

5. Click No.

By selecting no, you indicate that the changes are to be applied to the current 
session only. 

To change settings for the current session only
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If you are running MTE under Windows 95 or Windows NT, you can open more 
than one simultaneous Meridian MAX, CCR, or NAC supervisor session on your 
PC. The number of available sessions depends on the resources on your PC.

To open more than one session, you also need to select the Run in Separate 
Memory Space option in the Windows NT Property dialog box for your MTE 
icon.

If you are running MTE under Windows 3.1, only one MTE session can be 
opened.

If you are using a LAN, each session that you start takes up a LAN session on 
your application. If you are using a serial port and you want to run Meridian 
MAX, CCR, or NAC simultaneously, you must set up a separate port for each 
application.

A unique ID is required for each MTE session connected to the same Meridian 
MAX.

1. Double-click the MTE icon.

2. If desired, change the connection settings in the Edit Options dialog box or 
the Address Book dialog box.

3. Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new 
session.

4. Log in to the application.

5. To start another session, repeat steps 1 to 4. 

To connect to more than one session
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You can connect to a different Meridian MAX, CCR, or NAC application 
without terminating your current MTE session. This can be done through the 
Options dialog box or the Address Book dialog box. 

From the Options dialog box

1. From the Settings menu, click Edit Options.

The Options dialog box appears.

2. In the Alias Name field, select the alias name of the address book entry you 
want to use.

3. Click OK.

4. When prompted, click Yes or No to indicate whether you want to 
permanently save the changes.

5. Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new 
session.

6. Log in to the application.

From the Address Book dialog box

1. From the Sessions menu, click Address Book.

The Address Book dialog box appears.

2. Click the name of the address book entry you want to use.

3. Click Connect, or double-click the name of the address book entry.

4. Wait for your PC to connect to the Meridian MAX, CCR, or NAC in the new 
session.

5. Log in to the application.

To connect to a different application
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Restarting a session

This section describes how to restart a Meridian MAX, CCR, or NAC supervisor 
session from within the MTE window.

Note:  If you are connected to your application through a LAN, this 
procedure terminates the active supervisor session. Ensure that you have 
saved any changes you wish to use in future supervisor sessions before 
restarting the session.

If you are connected to your application through a serial port or modem, this 
procedure is equivalent to redrawing your screen.

1. From the Session menu, select Restart, or click the Restart button on the 
MTE toolbar.

A pop-up window appears asking if you want to restart the session.

2. Click Yes.

If you are connected to your application through a LAN, the active 
supervisor session is terminated.

If you are connected to your application through a serial port or a modem, 
the link is reconnected. Your supervisor screen disappears for approximately 
five seconds and reappears unchanged.

To restart a session
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Exiting MTE

This section describes how to exit MTE. You should log out of your Meridian 
MAX, CCR, or NAC supervisor session before you perform this procedure.

Note:  If you are connected to your application through a LAN, this 
procedure terminates the active supervisor session. Save any changes that 
you have made during the current supervisor session before you exit MTE.

1. Log out of the Meridian MAX, CCR, or NAC.

2. From the Session menu, select Exit, or click Exit on the MTE toolbar.

A pop-up window appears asking if you want to exit MTE.

3. Click Yes.

The MTE window closes.

If an MTE connection goes down unexpectedly, the system logs you off of the 
current supervisor session. 

This occurs if you are connected through one of the following:

• a LAN
• a modem
• a serial (RS-232) port connected to Meridian MAX 8.6x or higher

To exit from MTE

Losing a connection unexpectedly
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Saving to a file
This section describes how to save your Meridian MAX and NAC reports to a 
file that can be used in other applications. 

When you save your reports to a file, they are saved sequentially in the 
subdirectory and file name specified in the File field in the Options dialog box. 
For example, if you enter c:\directory\file in the File field in the Options dialog 
box, your first report is saved as c:\directory\file.001. Successive reports are 
saved as c:\directory\file.002, c:\directory\file.003, and so on, until 
c:\directory\file.999 is reached.

If a report is sent after you reach 999, a message box appears telling you that each 
new report that is sent will overwrite the final report. At this point, you can either 
delete files from your subdirectory, or specify a different file name. If you 
specify a different file name, ensure that the first eight characters of the new file 
name do not match the first eight characters of the old file name, or your new set 
of reports will overwrite your existing set of reports.

If you save to a file using data stream reporting, the data is reformatted so that it 
can be read by third-party software, such as spreadsheet or database packages. In 
the file, specific delimiters that are recognized by third-party software are added 
to the format of the report. To use this file format, you must have data stream 
reporting enabled on your Meridian MAX or NAC.

If you save to a file without enabling data stream reporting, the format of the file 
is not adapted for third-party use. In the file, the report appears as it would on a 
printed copy. Since the file is not reformatted, some third-party software 
packages may not be able to read the report.

File formats
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This procedure describes how to save a report to a file specified in the address 
book. The file can be used by third-party software applications.

1. From the Sessions menu, select Address Book, or click the Address Book 
button on the MTE toolbar.

The Address Book dialog box appears.

2. Click the name of the address book entry you want to use.

3. Click Modify.

4. In the Printer Port area, select File.

5. In the File field, type the path and file name.

6. Click OK to return to the Address Book dialog box.

7. With the name of the address book entry still highlighted, click Connect.

8. Wait for the PC to connect to the Meridian MAX or NAC.

9. Press {Control}{P} from any Meridian MAX or NAC supervisor screen.

The Local Printer Control Window appears.

To save to a file with data stream reporting
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10. In the Printer Type field, press the [Options] key.

The Printer Models pop-up window appears.

11. Select Data Stream. 

The Printer Models pop-up window disappears.

12. In the Printer Name field, enter a name.

This should be a descriptive name such as Data Stream.

13. Press the [Commands] key.

14. Select Save changes and exit.

A pop-up window appears asking you to confirm that you are about to add a 
local printer to the system.

15. Type Y.

A pop-up window appears informing you that the local printer is being 
added to the system.

Your reports are saved to the file that you specified in the address book 
entry. This file can be imported into a third-party software package. Due to 
the delimiters added to the report file by data stream reporting, the report 
appears in its original format when it is imported by the third-party software.

This procedure allows you to save a file specified in the address book. The file, 
however, is not reformatted for use by third-party software. This feature is only 
available for Meridian MAX.

1. From the Sessions menu, select Address Book, or click the Address Book 
button on the MTE toolbar.

The Address Book dialog box appears.

2. Click the name of the address book entry you want to use.

3. Click Modify.

4. In the Printer Port area, select File.

5. In the File field, type the path and file name.

6. Click OK to return to the Address Book dialog box.

7. With the name of the address book entry still highlighted, click Connect.

8. Wait for the PC to connect to the Meridian MAX.

To save to a file without data stream reporting
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9. Press {Control}{P} from any Meridian MAX supervisor screen.

The Local Printer Control Window appears.

10. Ensure that Data Stream or MTE Generic Printer does not appear in the 
Printer Type field.

11. Press the [Commands] key and exit the Local Printer Control window.

Your reports save to the file that you specified in the address book entry. 
This file is not reformatted for use by third-party software.

MTE allows you to send report data from the Meridian MAX to a file that is 
picked up by the MAXcaster forecasting tool. 

While this option is selected, you cannot send reports to your printer. You must 
be running Windows NT to run both MAXcaster and MTE on your PC. 

Note: The MAXcaster option is available only if MAXcaster is installed on 
your PC. 

In this procedure, an existing address book entry is modified to use the 
MAXcaster option. This is only one approach. You can also create a new address 
book entry with the MAXcaster option enabled, or access the setting through the 
Options dialog box.

1. From the Sessions menu, select Address Book, or click the Address Book 
button on the MTE toolbar.

The Address Book dialog box appears.

2. Click the name of the address book entry you want to use.

3. Click Modify.

4. In the Printer Port area, select MAXcaster.

5. In the File field, type the path and file name.

6. Click OK to return to the Address Book dialog box.

7. With the name of the address book entry still highlighted, click Connect.

8. Wait for the PC to connect to the Meridian MAX.

9. Press {Control}{P} from any Meridian MAX supervisor screen.

The Local Printer Control Window appears.

10. Ensure that Data Stream or MTE Generic Printer does not appear in the 
Printer Type field.

To save to a file for MAXcaster
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11. Press the [Commands] key and exit the Local Printer Control window.

Your reports are saved to the file that you specified in the address book 
entry. This file is not reformatted for use by third-party software.
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Copying text to the clipboard

This section describes how to copy a selection of text from your Meridian MAX, 
CCR, or NAC supervisor screen to your Windows clipboard. Once the text 
selection is in your clipboard, you can paste it into another application.

Note:  MTE does not support copying graphics to your clipboard.

1. Click and drag your mouse over the text that you wish to copy.

The text is highlighted.

2. From the Edit menu, select Copy, or click the Copy button on the MTE 
toolbar.

The text is no longer highlighted. You can now paste the selected text into 
another application.

To copy text to the clipboard
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Printing a report
This section describes how to use MTE to print your Meridian MAX or NAC 
reports. This feature is not available when MTE is connected to the CCR.

The following Meridian MAX or NAC reports can be printed from MTE:

• historical reports (tabular, graphical, and event log reports)
• system reports
• real-time display snapshots
• Configuration Control transaction logs
• configuration reports from the Meridian MAX Capacity Configurator 

(available in Meridian MAX only)

Note:  To print reports from the Meridian MAX maintenance terminal, 
follow the “To print reports with Meridian MAX 8.5x or lower” procedure 
on page 1-58.

The reports are printed only if

• there is only one MTE session running on the PC
OR

• there is more than one MTE session running on the PC, but all of the MTE 
sessions are connected through the LAN to a different Meridian MAX

 

If you have Meridian MAX 8.6x (or higher) or NAC 2.5, you can send reports to 
any printer supported by your PC. This can be a printer directly attached to the 
PC or accessible on a network.

1. From the Session menu, select Print Setup, or click the Print Setup button on 
the MTE toolbar.

The Print Setup dialog box appears.

2. Select the printer you want to use.

The default is the Windows default printer.

3. To change any of the other settings in the Print Setup dialog box, refer to 
your Microsoft Windows user guide.

4. Click OK to return to the MTE window.

The Print Setup dialog box closes.

To print reports with Meridian MAX 8.6x (or higher) or 
NAC 2.5
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5. From the Settings menu, select Edit Options, or click the Options button on 
the MTE toolbar.

The Options dialog box appears.

6. In the Printer Port field, click Printer (if not already selected).

7. Click OK.

8. Close the Options dialog box.

• If you modified the options and want to apply them to the address book 
entry, click Yes.

• If you modified the options and want to apply them only to the current 
session, click No.

• If no changes were made, close the Options dialog box.

9. Press {Control}{P} from any Meridian MAX or NAC supervisor screen.

The Local Printer Control Window appears.
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10. In the Printer Type field, press the [Options] key.

The Printer Models pop-up window appears.

11. Select the MTE Generic Printer option.

The MTE Generic Printer option appears in the Printer Type field. 

12. In the Printer Name field, type a name for the printer.

This should be a descriptive name, such as the name of the default printer.

13. Press the [Commands] key.

14. Select Save changes and exit.

A pop-up window appears asking you to confirm that you are about to add a 
local printer to the system.

15. Type Y.

A pop-up window appears informing you that the local printer is being 
added to the system.

16. Create a report in Meridian MAX or NAC. 

For more information on creating a report in Meridian MAX, refer to the 
Meridian MAX 9 Supervisor’s User Guide (P0881392), “Report Definition” 
chapter. 

For more information on creating a report in NAC, refer to the Network 
Administration Center (NAC) 2 Supervisor’s User Guide (P0724352), 
“Network Report Definition” chapter.

17. On the Meridian MAX or NAC screen used to create the report, press the 
[Commands] key.

18. Select Print this report.

The report is printed to the printer specified in the Print Setup dialog box.
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If you have Meridian MAX 8.5x or lower, you can send reports only to printers 
supported by your Meridian MAX. For a list of supported printers, refer to your 
Meridian MAX documentation.

Note: To print reports with Meridian MAX 8.5x or lower, the printer defined 
as your Windows default printer must be the same printer selected as your 
local printer in Meridian MAX.

1. From the Settings menu, select Edit Options, or click the Options button on 
the MTE toolbar.

The Options dialog box appears.

2. In the Printer Port field, click Printer (if not already selected).

3. Click OK.

4. Close the Options dialog box.

• If you modified the options and want to apply them to the address book 
entry, click Yes.

• If you modified the options and want to apply them only to the current 
session, click No.

• If no changes were made, close the Options dialog box.

5. Press {Control}{P} from any Meridian MAX supervisor screen.

The Local Printer Control Window appears.

6. In the Printer Type field, press the [Options] key.

The Printer Models pop-up window appears.

7. Select the printer that has been assigned as the Windows default printer.

8. In the Printer Name field, type a name for the printer.

This should be a descriptive name, such as the name of your printer.

9. Press the [Commands] key.

10. Select “Save changes” and exit.

A pop-up window appears asking you to confirm that you are about to add a 
local printer to the system.

11. Type Y.

A pop-up window appears informing you that the local printer is being 
added to the system.

To print reports with Meridian MAX 8.5x or lower
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12. Create a report in Meridian MAX.

For more information on the Meridian MAX reports, refer to the Meridian 
MAX 8 Supervisor’s User Guide (P0853407), “Report Definition” chapter.

13. On the Meridian MAX screen used to create the report, press the 
[Commands] key.

14. Select Print this report.

The report is sent to the printer.

If you experience problems printing reports to a local printer, follow these steps.

1. Make certain only one MTE session is running on your PC.

2. Ensure that your printer is configured properly and is accessible from your 
PC.

3. Try sending the report to the local printer again.

4. If the problem persists, open the Session menu and select Reset Registry.

The system automatically resets the registry in your Windows operating 
system. For detailed information on the registry, refer to your Windows 
documentation.

5. Try sending the report to the local printer again.

6. If the problem persists, contact your system administrator or Nortel 
distributor.

To fix a printing problem
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Previewing a report
This section describes how to preview a report in MTE before printing it. 

The Print Preview option is available only if

• you are connected to Meridian MAX 8.6x (or higher) or NAC 2.5
• a report, which has been generated in Meridian MAX or NAC, is ready to be 

previewed
• the report is targeted for the MTE Display

MTE can be used only to preview reports generated through the Report 
Parameter Definition feature in Meridian MAX or NAC. 

For more information on this feature, refer to the Meridian MAX 9 Supervisor’s 
User Guide (P08813927),  “Report Definition” chapter, “Report Parameter 
Definition” section. For more information on creating a report in NAC, refer to 
the Network Administration Center (NAC) 2 Supervisor’s User Guide 
(P0724352), “Network Report Definition” chapter.

Only one preview report is maintained by an MTE session. If more than one 
MTE session is running on the PC, each session maintains its own preview 
report.

Unlike reports targeted on the Meridian MAX for screen display, reports targeted 
for viewing through MTE are destroyed when the MTE session terminates. When 
the MTE session restarts, these reports must be regenerated to be previewed 
again.

When the Report Preview option is selected from the Meridian MAX main menu, 
the preview report that was generated to the VDT is displayed.

If a new preview report is generated through MTE, the previous preview report is 
erased.

Note:  This feature is not available when MTE is connected to CCR. 

1. On the Report Definition screen, create a report by defining the report 
parameters.

2. In the Output Device field on the Report Parameter Definition screen, press 
the [Options] key.

A pop-up window appears displaying available print options.

To preview a report
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3. Select MTE Display.

The pop-up window closes.

4. Press the [Commands] key.

5. Select Print this report.

A message appears on the screen when the report is ready to be previewed.

6. From the Session menu, select Print Preview, or click the Print Preview 
button on the MTE toolbar.

The report is displayed in the Print Preview window. 

Refer to your Microsoft Windows user guide for instructions on using the 
features in this window.
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Customizing programmable buttons
This section describes how to customize the MTE programmable buttons to 
automate actions in your Meridian MAX or CCR supervisor screens. With the 
press of one button, for instance, you can go directly from the Meridian MAX 
main menu to a frequently used screen. 

The buttons cannot be programmed to execute MTE dialogs or pull-down menus. 
The buttons are also not available in NAC.

The changes made to the programmable buttons from one MTE session apply to 
all other sessions running on the same PC.

If you are upgrading from an MTE 7 or 8 version, the programmable buttons 
from that version are used in MTE 9 until you redefine them. If MTE 9 is a new 
installation or an upgrade from MTE 6 or lower, the system provides a default set 
of programmable buttons for the Meridian MAX screens. The following are the 
defaults:

Button Button Name Key Sequence

1 Exit 1 <F1>

2 F2 <F2>

3 F3 <F3>

4 F4 <F4>

5 F5 <F5>

6 F6 <F6>

7 F7 <F7>

8 F8 <F8>

9 F9 <F9>

10 F10 <F10>

11 F11 <F11>

12 F12 <F12>
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Applying buttons in Meridian MAX 8 or above

If you are using Meridian MAX 8 or above, you can program up to 12 different 
buttons on each screen. The buttons are defined for the screen currently being 
displayed in MTE. For example, if Meridian MAX screen “A” is displayed, the 
buttons defined in the Customize Buttons dialog box are loaded only when 
screen A is displayed. If screen B is displayed, a new set of buttons can be 
programmed. This feature is called context-sensitive programmable buttons.

If you have an MTE 9 directly connected to the Meridian MAX 9, the terminal 
type must be set to “MTE 9 or above” to use the buttons.

If you have an MTE 9 directly connected to a Meridian MAX 8, the terminal type 
must be set to “MTE 8 or compatible.”

If MTE  is connected through a LAN, it automatically creates the appropriate 
setting.

Applying buttons in Meridian MAX 7 or lower

If MTE is connected to Meridian MAX 7 or lower, or the terminal type for a 
direct connection is set to “MTE.” the context-sensitive buttons cannot be used. 
Rather, the same set of programmable buttons is used by all the Meridian MAX 
screens regardless of the screen being displayed. This same set of buttons is also 
used by all of the Meridian MAX screens if

• the emulation type in the Options dialog box  is set to MAX, and the MTE 
connection is being established

• the emulation type in the Options dialog box is set to MAX, and the MTE 
connection cannot be established due to error

Applying buttons in CCR

You can define a set of programmable buttons that are exclusively used when 
MTE is connected to a CCR host. 

The same set of 12 CCR-specific programmable buttons is used by all CCR 
screens. Context-sensitive buttons cannot be programmed for each screen.

To define the programmable buttons for CCR, MTE must be connected to a CCR 
host. These buttons are used if

• MTE is connected to CCR, and the emulation type in the Options dialog box 
is set to CCR
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• the emulation type in the Options dialog box is set to CCR, and the MTE 
connection is being established

• the emulation type in the Options dialog box is set to CCR, and the MTE 
connection cannot be established due to errors

If MTE is a new installation, the system provides a default set of programmable 
buttons for the CCR screens. The following are the defaults:

Button Button Name Key Sequence

1 F1 <F1>

2 F2 <F2>

3 F3 <F3>

4 F4 <F4>

5 F5 <F5>

6 F6 <F6>

7 F7 <F7>

8 F8 <F8>

9 F9 <F9>

10 F10 <F10>

11 F11 <F11>

12 F12 <F12>
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To help you program a button, an example is provided in this procedure. The 
example shows how to design a button to read an existing formula into the 
Formula Definition screen in Meridian MAX.

1. Check your terminal type.

• If you are using Meridian MAX 9 or above and a serial port, set the  
terminal type to “MTE 9 or above.” Press {Control}{T} on any  
Meridian MAX screen to check the terminal type.

• If you are using Meridian MAX 8 and a serial port, set the terminal type 
to “MTE 8 or compatible.” Press {Control}{T} on any Meridian MAX 
screen to check the terminal type.

• If you are using a LAN connection, the terminal type is automatically set  
by MTE.

2. If your programmable buttons are not displayed on the bottom of your MTE 
window, select Programmable Buttons followed by Enable on the Settings 
menu, or click the Enable button on the MTE toolbar.

The programmable buttons appear at the bottom of the MTE screen.

To define buttons for Meridian MAX 8 and above
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3. Go to the Meridian MAX screen you would like to associate the 
programmable button with.

Example: Display the Meridian MAX main menu. 

4. From the Settings menu, select Programmable Buttons followed by Edit, or 
click the Customize Buttons button on the MTE toolbar.

The Customize Buttons dialog box appears.

5. In the Programmable Buttons box, click the button that you want to 
customize.

The word Edit appears in place of the number of the programmable button. 
The button name and key sequence currently assigned to that button appear 
in the Content group box.

Example: In the Programmable Buttons area, Button 2 is selected to be 
programmed. The Content area shows how the Button Name field and Key 
Sequence field appear when programming is complete.
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6. In the Button Name field, type a name for the button. 

The name can be a maximum of eight characters. This name appears when 
the programmable buttons are displayed in the MTE window.

Example: In the Button Name field, the name Formula is assigned. 

7. In the Key Sequence field, type the key sequence that you want to automate. 
From the Terminal Keys pull-down list box, double-click any key that you 
want to include in the sequence.

Use the characters <CR> to indicate a carriage return. The carriage return 
symbol can be selected from the Terminal Keys pull-down list.

Example: The key sequence is 6<CR>5<CR><F1>3<CR>12<CR><F1>

To enter this sequence, do the following:

ENTER TO

6<CR> Select the Report Definition feature from the Meridian MAX 
main menu. The Report Definition pop-up window is 
displayed.

5<CR> Select the Formula Definition feature from the Report 
Definition pop-up window. The Report Formula Definition 
screen is displayed.

<F1> Display the Commands window. The <F1> key should be 
selected from the Terminal Keys pull-down list.

3<CR> Select the “Read an existing formula” option. The list of 
existing formulas is displayed.

12<CR> Select the “Number of calls accepted” formula. This formula is 
Number 12. The formula is displayed on the screen.

<F1> Close the Commands window. The <F1> key should be 
selected from the Terminal Keys pull-down list.

8. Repeat steps 5 to 7 to customize any other buttons for this screen.

9. Save your programmable buttons.

• If you want to use the new buttons for the current session, click OK. 
When asked if you want to save the buttons as the system default, click 
No.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear during the current session only.
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• If you want to use the new button as the system default, click Make 
Default.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear. 

10. Repeat steps 3 to 9 to assign buttons to other Meridian MAX screens.

If you are connected to Meridian MAX 7 or lower, you can create only one set of 
programmable buttons to use on all the screens.

1. Check your terminal type.

• If you are using Meridian MAX 7 (or lower) and a serial port, set the 
terminal type to “MTE.” Press {Control}{T} on any Meridian MAX 
screen to check the terminal type.

• If you are using a LAN connection, the terminal type is automatically set 
by MTE.

2. If your programmable buttons are not displayed on the bottom of your MTE 
window, select Programmable Buttons followed by Enable on the Settings 
menu, or click the Enable button on the MTE toolbar.

The programmable buttons appear at the bottom of the MTE screen.

3. Navigate to any Meridian MAX screen.

4. From the Settings menu, select Programmable Buttons followed by Edit, or 
click the Customize Buttons button on the MTE toolbar.

The Customize Buttons dialog box appears.

5. In the Programmable Buttons box, click the button that you want to 
customize.

The word Edit appears in place of the number of the programmable button. 
The button name and key sequence currently assigned to that button appear 
in the Content group box.

6. In the Button Name field, type a name for the button. 

The name can be a maximum of eight characters. This name appears when 
the programmable buttons are displayed in the MTE window. 

To define buttons for Meridian MAX 7 or lower
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7. In the Key Sequence field, type the key sequence that you wish to automate. 
From the Terminal Keys pull-down list box, double-click any key that you 
wish to include in the sequence.

Use the characters <CR> to indicate a carriage return. The carriage return 
symbol can be selected from the Terminal Keys pull-down list.

8. Repeat steps 5 to 7 to assign any other buttons.

9. Save your programmable buttons.

• If you want to use the new buttons for the current session, click OK. 
When asked if you want to save the buttons as the system default, click 
No.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear during the current session only.

• If you want to use the new buttons as the system default, click Make 
Default.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear. 

 

Only one set of programmable buttons can be created in CCR. The same set of 
buttons is available for all the screens.

1. Navigate to any CCR screen.

2. If your programmable buttons are not displayed on the bottom of your MTE 
window, click Programmable Buttons followed by Enable on the Settings 
menu, or click the Enable button on the MTE toolbar.

The programmable buttons appear at the bottom of the MTE screen.

3. From the Settings menu, select Programmable Buttons followed by Edit, or 
click the Customize Buttons button on the MTE toolbar.

The Customize Buttons dialog box appears.

4. In the Programmable Buttons box, click the button that you want to 
customize.

The word Edit appears in place of the number of the programmable button. 
The button name and key sequence currently assigned to that button appear 
in the Content group box.

To define buttons for CCR
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5. In the Button Name field, type a name for the button. 

The name can be a maximum of eight characters. This name appears when 
the programmable buttons are displayed in the MTE window. 

6. In the Key Sequence field, type the key sequence that you wish to automate. 
From the Terminal Keys pull-down list box, double-click any key that you 
wish to include in the sequence.

Use the characters <CR> to indicate a carriage return. The carriage return 
symbol can be selected from the Terminal Keys pull-down list.

7. Repeat steps 4 to 6 to assign values to the buttons.

8. Save your programmable buttons.

• If you want to use the new buttons for the current session, click OK. 
When asked if you want to save the buttons as the system default, click 
No.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear during the current session only.

• If you want to use the new buttons as the system default, click Make 
Default.

The Customize Buttons dialog box closes, and the buttons that you 
customized appear. 

A programmable button file can be exported from MTE and saved into a file. 
This file can then be imported to other PCs running MTE. You should not use 
other applications to alter the contents of the exported programmable buttons file.

Note: A set of programmable buttons must be saved as the system default 
before it can be exported.

1. From the Session menu, select Export File.

2. From the Export File submenu, select Programmable Buttons.

The Save As dialog box appears.

3. Assign the directory and file name to be used to store the programmable 
button file.

4. Click Save.

The programmable button file is saved. The system automatically formats 
the programmable button file for use exclusively by MTE.

To export programmable buttons

MTE9UserBook : e10_but  Page 70  Friday, October 2, 1998  2:10 PM



Customizing programmable buttons

MTE User Guide 1-71 Product release 9

A set of programmable buttons can be imported and shared by other PC users 
running Microsoft Windows. Do not use other applications to alter the contents 
of a programmable buttons file.

Only a programmable buttons file that has been exported from MTE on a PC can 
be imported.

1. Copy the exported programmable button file to your PC.

2. From the Session menu, select Import File.

3. From the Import File submenu, select Programmable Buttons.

The Open dialog box appears.

4. Locate the directory and folder containing the programmable buttons. 

5. Highlight the programmable button file to be imported.

6. Click Open.

The selected programmable button file is copied to MTE. If a programmable 
button file is already in use, a dialog box appears asking if you want to 
overwrite it with the imported file. 

7. Click Yes to confirm the import.

To import programmable buttons
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Selecting your font settings
This section describes how to select the font settings used in your Meridian 
MAX, CCR, and NAC supervisor screens. The size of the window changes with 
the font size that you select. Depending on the system fonts supported on your 
PC, you may also be able to select from the following fonts: Terminal, IBM PC, 
and 8514 OEM. The Terminal font is available on any PC.

Note: If you have more than one MTE session running on your PC, any change 
made to the font settings in one session is applied to all the other active MTE 
sessions.

1. From the Settings menu, select Font.

2. From the Font submenu, choose Select.

The Font dialog box appears. 

3. Select the font and size you want to use.

Refer to your Microsoft Windows user guide for directions on using this 
screen. 

4. Save your selections and return to the MTE window.

The new settings are used in future Meridian MAX, CCR, and NAC 
supervisor sessions until they are changed.

MTE allows you to select the font settings to be used as the system default.

1. From the Settings menu, select Font.

2. From the Font submenu, select Default.

The font settings change to the default. The default font is used in future 
supervisor sessions until you select new settings.

To select your own font settings

To select the default font settings
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Selecting your color settings
MTE allows you to access the Meridian MAX color customization feature while 
you are running Meridian MAX. 

This feature gives you the ability to specify the colors for each display element 
on your Meridian MAX supervisor screens. For more information on 
customizing colors, refer to the Meridian MAX 9 Supervisor’s User Guide 
(P0881392), “Color Customization” chapter.
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